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Opening ......c.ccvee... Cassandra Youngblood
» Welcome / Introductions

» Opening Remarks/Housekeeping
AG E N DA » Disclaimer: Webinar is being recorded
. RFP Overview ............ Cassandra Youngblood
» RFP Timeline/Introduction
» Required Proposal Format
» General Submittal Requirements

» Evaluation Process — 3 parts
> Appeals Process

Ill. RFP Program................ Noramah Burch
Program Overview

Purpose and Scope of Work
Reporting Requirements

Proposal Narrative

Budget & Budget Narrative

Proposal Evaluation Process & Scoring

IV. RFP Fiscal......ccoiviiniinnnn. Molly Almeida
» Fiscal Review
» Fiscal Requirements & Attachments
» Fiscal Monitoring
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RFP Overview

»RFP Timeline
> RFP Intfroduction

»Required Proposal Format

»RFP Submission Instructions
> Evaluation Process

» Appeals Process




PROPOSAL
DUE DATE

SECTION 2: RFP SCHEDULE AND TIMELINE

Page 5

Event/Location

Date

RFP Published and Announced

January 30, 2025

Virtual Bidder's Conference/Informational Session

February 12, 2025

RFP Questions due to EHSD

February 12, 2025

Responses to RFP Questions Published by EHSD

February 19, 2025

Deadline for RFP Submission to EHSD

March 7, 2025

EHSD Compliance Evaluation

By March 13, 2025

EHSD Fiscal Evaluation

By March 24, 2025

WDEB Program Review and Evaluation

By April 14, 2025

Award Letter Sent

April 15, 2025

Appeal Period (10 business days after Award Letter issuance)

Concludes April 28, 2025

Contract Negotiation and Processing

April 28 —May 15, 2025

Anticipated Contract (s) Start Date

July 1, 2025

All dates are subject to change as deemed in the best interest of EHSD.

With the exception of submission deadline, all dates are subject to change.




RFP Introduction

» Qualified Bidders Page 6 -7
» Ex Parte Communication Page 9
» Submit RFP questions by 5 pm today Page 9

Submit via webinar “*Question” box OR via email to contractbid@ehsd.cccounty.us

» Right to Amend or Cancel Page 9

Read the entire RFP carefully!



Qualified Bidders

Eligible Bidders must have administrative and programmatic capacity and expertise to
provide these services.

Bidders MUST NOT be debarred, suspended or otherwise excluded from, or ineligible
for participation in Federal Assistance programs.

Bidders MUST have:
« Documented success with similar programs with tfrack record of positive
outcomes for long-term employment.

« Demonstrated capacity to operate and administer a federally funded program.
« Demonstrated experience in collaboration and coordination of services.
* In-depth knowledge of Contra Costa County.



Qualified Bidders (continued)

Two types of proposals may be submitted:

< Single Organization
< Non-profit, For-profit, Public agencies

< Formal Parinerships with more than one entity

<+ ONE organization will be the main contracting entity
with legal and fiduciary responsibility for the
partnership



Ex-Parte Communication § e 9

Ex-parte communication restricts RFP
bidders from contacting county staff to
provide information regarding this RFP,
except regarding proposal submission
instructions. Ex-Parte will begin at the
conclusion of this Bidders’ Conference.



How to submit questions
about RFP 1218

SUBMIT VIA WEBINAR “QUESTION” BOX

SUBMIT VIA EMAILTO
BY 5 PM TODAY



mailto:contractbid@ehsd.cccounty.us

Right to Amend or Cancel

RFP may be delayed, amended or canceled, in whole or
in part, at any time without prior notice.

Process and timeline may be modified as deemed
necessary.

RFP does not commit EHSD to accept any proposal.

EHSD is not responsible for any bid preparation costs
incurred by Bidders.



Required
Proposal Format

Section 6.2
Pages 18 - 25

Single-spaced, 8 2" x 11" page
size, with one (1) inch margins. Use
no less than12-point font.

No artwork / unusual graphics.

Complete proposal narrative may
not exceed twenty (20) pages.

Arrange in the order outlined in
Section 6.5: PROPOSAL CHECKLIST
(page 24) and number pages
sequentially (excluding Fiscal
Addendums).

MUST include all required forms
Section 9: REQUIRED FORMS
(page 32)




PROPOSAL FILE [File #1: Save as “RFP 1218-Agency Name-Proposal™]

I:l 1. Proposal Cover Statement (Form #1)
O 2. Statement of Qualifications (Form #2)
I:l 3. Project Proposal Marrative (Max 20 pages)
O Organization Description and Qualifications (10
points)
O Program Design (20 points)
O Program Components (25 points)
O Past Performance (15 points)
O Measures and Results (15 points)
D 4, attachments
O Client Flow Chart {Include with Proposal)

O Proposed Performance Table (Form #3)

O Organizational Chart {(Include with Proposal)

O Budget and Budget Narrative (Form #4] (15
points)

FISCAL FILE [File #2: Save as "RFP1218-Agency Name-Financials"]

D Fiscal Management Narrative
Include a brief description of the organization’s accounting system
and internal controls. Describe fiscal policies and procedures or
reference what is attached in the Fiscal Attachments section. Include
descriptions of the following as appropriate: imekeeping system,
payroll system, inwventory system, cost allocation plan and the
methodology used to prorate common operating costs. Explain the
ledger system  used for receivables, payables, expenses,
dishursements, and petty cash.

Fiscal Attachments

O Copy of bidder's IRS S01(c)(3) determination letter attached to
original proposal copy (if agency is a non-profit organization).

O Copy of bidder's manual of fiscal procedures and policies, if ovailable.

O Copy of bidder's most recent audit including any applicable
corrective action plans. A review or compilation of the financial
statements prepared by a CPA may be submitted in lieu of an
audit/audited financial statements if the latter are not available. A
copy of the latest filed tax return must be submitted if a review or
compilation is not available. Bidders who currently do not hawve
gudited financial statements must provide a certified letter stating
that a financial statement audit will be performed during the peried
of performance should the bidder be awarded the contract.

O Copy of current &agency or Department Budget with revenue
sources indicated. If you are applying a5 a department within a
large agency, then the budget of the department may be
submitted. Indirect costs included in the budget must be supported
[MICRA or de minimis applied to Modified Total Direct Costs or
other approved Cost Allocation Plan).




General Submitial Requirements  page 17

Electronic Submission - RFP submissions are accepted via EHSD.org website only.

Submissions must be separated into two (2) files. The first file will be the agency
proposal, and the second file will be the agency financial documents.

» File #1: Save as “RFP 1218 - Agency Name - Proposal”.

» This file must contain agency proposal, and all required attachments as specified in the RFP
and must be signed by officials authorized to bind the bidder/applicant to the provisions of the
RFP.

» File #2: Save as “RFP 1218 - Agency Name - Financials”.

» This file must contain all required financial documents as specified in the RFP.

» Call (925) 957-5645 and follow instructions to register bid subbmission.

Read the entire RFP carefully!



FORM #1

page 33

Proposal Cover
Statement

MUST BE THE 15" PAGE
OF YOUR PROPOSAL

FORM #1: Proposal Cover Statement

0.1 Form #1: Proposal Cover 5tatement RFP 1218
Program: WIOA Youth Program Services

A. Bidder Organization Mame

B. Address & Wehbsite:

C. Mame{Title of Contact Person(s)

D. Phone/E-mail of Contacts

E. FEIM #

F. Unigue |D # [sam.gov]

G, Are you MBE/WEE certified? Yes Mo Certifying Agency:

H. Proposed Program Service Delivery | East/Far East County [J
Areals)fLocationis) West County [
Central County O

l. Number of youth to be served: # of Qut-of-S3chool Youth # of In-5chool Youth

1. Number of Partnering

L Total Funds Requested £
Organizations:

K. Type of Organization: [for-profit, [ non-profit O public agency

L. Provide a brief synopsis of the proposed program. Your synopsis is limited to this space:

AUTHORIZATION

We submit the attached response to the Motice of Reguest for Proposal No. 1218 dated and all
attachments and declare that: If this Response is accepted by the Board of Supervisors of Contra Costa County, we will
enter into a standard contract with Contra Costa County to provide all work specified hersin at the costs, which we
have proposed, or in accordance with modifications required by Contra Costa County. Funds obtained through this
contract will not be used to supplant funding for other programs operated by the bidder/contractor.

Signoture af Autharized Representative / Titke Dt

Kignoture af Autharized Representative / Titke Dt




Evaluation Process

pages 25-27

1. Compliance

> Proposal will be
reviewed for
compliance with
submission
requirements.

> Pass / Fail

2. Fiscal
» Proposal will be

evaluated for fiscal
components such as
agency solvency and
ability o administer
financial systemes.

Must receive a score of
70% to continue to
Program Review.

3. Program
» Proposal will be

evaluated for program
components as outlined
on pages 27 — 28.

Must receive a score of
70% to be considered
for funding award.



Appeals Process

APPEALS PROCESS

Only responding Bidders may file an appeal

Appeals to funding decisions must be
submitted to the EHSD Director no later
than 5 p.m. on the 10" business day after
award notification

Written letters of appeal mailed to:
EHSD Director

40 Douglas Drive
Martinez, CA 94553

Electronic submission:

contfractbid@ehsd.cccounty.us

19
pages 28-29

WRITTEN APPEAL REQUEST MUST INCLUDE THE
FOLLOWING:

>

>
>
>

Ared(s) of contention
Citation of regulation or policy violated
How the organization was damaged

A recommended solution

Read the entire RFP carefully!



RFP Response Process RE-CAP

<+ Submit Bid by March 7, 2025

> Call (925) 957-5645 and follow instructions about confirming submission

< Submit questions about RFP process during this Bidders Conference or by email to

confractbid@ehsd.cccounty.us by 5pm today.

< After Bidders' Conference, Ex-Parte will be in place and contact with EHSD is not

allowed (except for submission assistance).


mailto:contractbid@ehsd.cccounty.us

Workforce Development Board (WDB)
Program Review

Noramah Burch, Administrator




RFP Overview

» YOUuTh Services under WIOA
»WIOA Youth Eligibility

»Program Design components
> 14 WIOA Youth EIERIETRIS

»Other local board priorities




Funding and Funding Priorities (page 7) 29

estimated $1 .2 Mil

WIOA requires Local Priority: Minimum
/5% of 40%
of the funding for of WIOA youth funds fo
be spent on

services for |
Out-of-School Youth work-experience



Service Delivery Areas

(page 8)

> West ColilifieREOS1C

> Centrdl @EREERC osia
» East ConiiicIRessie)




WIOA Youth E||g|b|||1'y (pages 14-15)

Out of School Youth In-School Youth
Eligibility based on Eligibility based on
1. Age 1. Age

2. School Status School Status

2
3. Challenge 10 3. Challenge to Employment
4

Employment Low Income



WIOA Youth Out-of-School (page 15)

Age 16-24

Not Any Aftending

School
Or

Attending - Adult Ed /
Youth Build / Job

Corps
Low Income+
Under 18 & Not Homeless, HESqiir\?adIZz:e
School Al el Justice SUEIE, Pregnant or Disabilit '
most recent Foster Youth, P i Y Basic Skills
Dropout Involved SR
school year Former Foster Deficient
calendar quarter OR

Youth

English Language
Learner




WIOA Youth In-School (page15)

Age 14-21

Attending School

Except Adult Ed/Youth Build/Job Corps
— See OSY definition

Low Income

Homeless/ Pre
. . gnant
Blesie Angl il Justice Runaway/ or Disability
Skills Language Foster Youth/
. . Involved
Deficient Learner Former Foster
Youth

Parenting




Program Design/

14 Youth Program Elements
(pages 12 -13)

It is not expected that one organization

Clicking on the element name in the will provide all 14 Youth Elements, but the
> RFP takes you to detailed info elements do need to be made available

to youth participants
> Definition of the element

> Examples of strategies

> Other WIOA Youth Program
Resources

» Partnerships with other organizations
» Cross-training
» Referrals



WIOA Program Flow (pages11-13)

1

INTAKE/
ELIGIBILITY INDIVIDUAL SERVICES
STRATEGY




WDB Priority Industries (page 13)

Board Priority Industries
» Advanced Manufacturing,
» Health and Life Sciences,

> Co(rjws’rruc’rion/Energy/Engineering,
an

» Information Communications
Technology including Digital
Media

» Transportation & Logistics

Other Recognized Sectors
» Automotive

» Education

» Public Sector/Government

Bidders may identify additional
priority sectors in their proposals but
should make the case for their
inclusion. Proposals will be evaluated
on the quality of connections and
level of collaboration with industry.



Placement in employment, education, or
training: The percenfage of participants who
are in employment, education, or training
during the 2" quarter after program exit.

WIOA
Performance

Measures
(pages 15 -16)

Placement in employment, education, or
training: The percentage of participants who
are in employment, education, or fraining
during the 4th quarter affer program exit.

Earnings after entry into unsubsidized
employment: The median earnings of

participants who are in employment during
the 2nd quarter after program exit.




WIOA
Performance

Measures
(continued)

who obtain a
high school diploma, HISET, GED must also gain
employment, enroll in advanced fraining, or
enroll in posf-secondary).

Measurable skills gains: Percentage of
participants in an education or training
program that leads to a recognized
postsecondary credential or employment and
who are achieving measurable skill gains,
defined as documented academic, fechnical,
occupational or other forms of progress towards
such a credential or employment.



WORKFORCE INMNOVATION AMND OPPORTUMITY ACT (WIHODA)

e~ N TITLE | YOUTH PROGRAM SERWVICES
F O RM #3 9.3 Form #3: Table of Proposed Performance Outcomes

REQUEST FOR PROPOSALS (RFP) # 1218
pdge 36 Bidder Organization

a. Total Funds Requested &
b. Approximate Cost Per Participant

Tq b I e Of P ro p o se ° c. # of Out-of-School Youth to be served

d. # of In-School Youth to be served

Performance . incustry Focus (f applicatic

WIOA Performance Lewvels [Section 5.5) — Enter proposed number (#) and Percentage (%)

Placement in employment or Post-Secondary Education a=
Quarter after exit

Placemeaent in Employment or Post-secondarny Education a®
Ouarter after exit

Median Earnings z«2 quarter after Exit

Credential Attainment
recognized credential or secondary diploma/eguivalent duwring participation or
within 1 year after program exit

Measurable Skills Gain
Documented academic, technical, ccoupational, or other forms of prograss
towards such a credential or employment

Other Outcomes the Bidder Proposes (if any) — Specify Type and How Measured
(example: Customer Satisfaction via survey or exit interview)




Budget & Budget Narrative
(Form #4 page 37)

Budget Category Other Sources of Revenue
Descriptions (if applicable)
» Personnel & Fringe Benefits » Match and/or Leverage

» Operating Costs
» Other Costs

> Participant Cosfs Note: WIOA prohibits

» Indirect/Overhead &/or supplantation of funds
Administrative



FORM #4: Program Budget and Budget Narrative

PROPOSED COUNTY
BUDGET CATEGORY DESCRIPTION COST REIMBURSEMENT Euﬁgglnﬁg:gm
AMOUNT
FO RM #4 PERSONNEL AND FRINGE BENEFITS 3
page 37 OPERATING COSTS 3
d OTHER COSTS 3
PARTICIPANT COSTS 3
INDIRECT OVERHEAD AND/OR ADMINISTRATIVE COSTS 3
TOTAL COUNTY COST REIMBURSEMENT AMT:|
OTHER SOURCES OF REVENUE OTHER SOURCES BUDGET NARRATIVE
(if applicable) REVENUE AMOUNT (Other Revenue Sources)
PP (i applicable)
TOTAL OTHER REVENUE:| $




RFP Scoring Methodology (page 2s)

Organization Description and Qualifications 10
Program Content (Program Design) 20
Program Content (Program Components) 25
Past Performance 15
Measures and Results 15
Budget and Budget Narrative 15

Total Available Points 100



Fiscal Contact

Molly Almeidao- Fiscal Analyst




Fiscal Agenda

» Fiscal Review
» Fiscal Requirements & Attachments

» Fiscal Monitoring

Read the entire RFP carefully!



Fiscal Review

» Fiscal Review — pages 26-27.

Proposal will be reviewed for fiscal components such as organization
solvency, adequate accounting systems and internal controls, ability to
administer financial systems, and compliance with budget specifications.

Must receive a score of 70% to continue to Bureau Evaluation.

Proposals that do not provide the required audit or financial statements
outlined in the proposed format will be determined nonresponsive and not
be considered for funding.

Read the entire RFP carefully!



Fiscal Requirements & Attachments

» Fiscal Management Narrative — page 25
» A brief descriptfion of the organization’s accounting system and internal controls:
o Overall system
o Timekeeping system
o Inventory system
o Payroll system
o Cost allocation plan and methodology
o Ledger system for receivables, payables, expenses, disbursements, petty cash
Describe how the agency’s fiscal system is administered and by whom:

o Include responsibilities of the Board of Directors, Executive Director and staff in
fiscal management.

o Describe the experience and qualifications of fiscal staff.



Fiscal Attfachments

» Fiscal Attachments, Cont. (page 25)
IRS 501(c)(3) determination letter
Manual of fiscal procedures and policies, if available
Last audited financial statement
Current Organization Budget with revenues and expenses indicated

Read the entire RFP carefully!



Fiscal Monitoring

> It is EHSD Fiscal’s monitoring responsibility fo ensure that claimed costs are
substantiated by your accounting records.

EHSD will conduct routine fiscal monitoring of all programs
Record Keeping:

o Contractor will be expected to maintain complete up-to-date and
accurate records and management controls.

o Confractor will complete any required county/state and/or federal data
collection forms as supplied by EHSD.

o Maintain adequate records of service provision to document compliance
m’rh service plan and information on the performance outcomes stated in
is RFP.

Read the entire RFP carefully!
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Please read the entire RFP carefully!




FINAL NOTES

< Submit Bid via ehsd.org only by 5:00 PM, March 7, 2025.

> Call (925) 957-5645 and follow instructions about confirming submission

< Submit final questions about RFP by email to conifractbid@ehsd.cccounty.us by 5 pm
today. Responses will be posted on ehsd.org on 2/19/25.

/

<+ Ex-Parte is now in place. Further contact with EHSD or WDBCCC staff is not allowed
(except for response submission assistance).


mailto:contractbid@ehsd.cccounty.us
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